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Introduction 
 
If your company imports merchandise from abroad, you need container management. It 
can help track the contents of containers, their estimated and actual shipment dates, 
statuses and their costs. 
 
The Achieve Container Management module performs all of these functions.  It 
integrates completely with SAP Business One Purchase Orders, Goods Receipt PO’s, and 
Landed Costs.  It provides all of the added features you need to stay informed at all 
stages of the shipment.  Reports by shipment status are also included. 
 
Achieve Container Management includes the following features: 
 
 

 Container Entry 
 

o Copy from Purchase Order(s) 
o List all Items 
o Enter Container Identification 
o Enter Estimated Dates 

 

 Container Details 
 

o List by Item or by Container 
o Shows Container Types and Sizes 
o Shows Items in Each Container 

 

 Projected Landed Costs 
 

o Enter costs as they become known 
o Cost Codes from Purchasing A/P module 
o Calculate Landed Cost at any time 

 

 Pre-Payments 
 

o Create Reserve A/P Invoices for items in Containers 
o Pay before or after items are shipped 

 
  

 
  



  
 

3 | P a g e  A c h i e v e  C o n t a i n e r  M a n a g e m e n t  U s e r  G u i d e  

 

 Container Processing 
 

o Ship Items 
o Items at Port 
o Items Cleared 
o Items Released 
o Items Received 

 Creates Goods Receipt PO 
o Push Landed Cost 

 Creates Landed Cost Document 
 

 Reports 
 

o By Item 
o By PO/Vendors 
o By Customer 
o By Tracking Number 
o Items in Transit (prepaid) 
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Special Features 
 

Multiple Vendors 
 
Purchase Orders from multiple vendors can be included in the same Container 
shipment.  On receipt, the system will create a separate Goods Receipt PO for each 
vendor and a separate Landed Cost document for each vendor.  Costs are apportioned 
based on the total shipment and divided proportionately to each Landed Cost 
document.  The target Goods Receipt PO number is shown for each line on the 
Container Entry screen. 
 

Multiple Currencies 
 
If the original Purchase Orders that are on a Container include different currencies, the 
system will translate them into the system currency for Container Processing.  However, 
the Goods Receipt PO’s that are created will be displayed in the currency of their base 
Purchase Orders.  Landed Cost documents will also reflect the currency of their 
respective base Goods Receipt PO’s. 
 
Additional costs must be entered in system currency and will be translated into the 
document currency of the Landed Cost document.  A system option allows you to 
choose whether to use the exchange rate that was on the original PO or the one that is 
current on the day of receipt. 
 

Multiple Weight Units of Measure 
 
On occasion items are purchased that have different units of measure for weight (for 
example, some may be weighed in ounces and others in pounds).  When costs are 
apportioned by weight it is necessary to use a common unit of measure so that the 
landed cost can be calculated correctly.  Achieve Container Management will translate 
the weights into the smallest unit of measure (ounces, in this example) so that the 
landed costs are correct.   
 

Document Links 
 
Achieve Container Management allows you to link various files and documents to a 
shipment.  You can do this for an unlimited number of files of any type that are stored 
on your network.  These might be scanned copies of shipping documents, spreadsheets, 
certifications, graphics, or any other documents that are relevant to the shipment.  You 
may view or print the documents directly from the Container Entry screen.  
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Links to Customers 
 
In some instances, items on Containers are designated for specific customers.  When 
creating a Sales Order, you may create a link to a Purchase Order through standard 
Business One procedures.  This is most often done in conjunction with drop ship 
warehouses, but it can be done in other situations as well.  In this case, the system 
creates a Purchase Order with a base document that is the Sales Order.  If the Purchase 
Order is later copied to a Container document, the link to the original Sales Order is 
maintained. 
 
In Achieve Container Management, there is a report of Containers by Customer that 
will show only items that are on these linked shipments.  It is also possible to view 
Container information for items on Sales Orders by means of a right-click option in the 
Sales Order screen. 
 

Pre-Payments 
 
Some vendors may require payment before shipping merchandise from abroad, or the 
payment may be due after shipment but before the items are received.  Achieve 
Container Management allows you to copy some or all of the items on a Container to 
A/P Reserve Invoices.  The Reserve Invoice number is referenced on the Container 
screen, and it becomes the base document for the Goods Receipt PO that will be 
created when the items are received. 
 

Integration with Achieve Warehouse Management 
 
If you are also using Achieve Warehouse Management (WMS) you may receive items 
from Containers by means of the handheld devices.  It is not necessary to enter the 
individual PO numbers since a menu option on the handheld will permit Container 
receiving.  Multiple people can receive items from the same Container simultaneously 
or at different times.  The received quantity of each item will be shown on the Container 
Entry screen.   
 
See the section below labeled Container Management with Achieve Warehouse 
Management for fully detailed information. 
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Setup 

Container Management Configuration 
 
Administration > Achieve One Set Up > Achieve Container Management > Container 
Management Configuration 
 
This screen allows you to set certain options regarding Container Management. 
 

 
 
 
Container Report: Enter the full path name for the Crystal Reports template for the 
Container Entry form.  You may use the choose-from button to browse to the file 
location.  Note that if you are using the Achieve One Report Launcher to print your 
container report, you do not need to make an entry in this field. 
 
Display Currency: Choose the default display currency for containers; System or Local 
 
Currency Exchange Rate: Select the desired setting for exchange rates when foreign-
currency Goods Receipts PO’s and Landed Cost documents are created. 
 

PO Exchange Rate Use the rate from the base Purchase Order 
 

Current Exchange 
Rate 

Use the rate of the date when the new documents are 
created 

 
Copy Broker ID: Check this box if you wish the Broker ID on the Container document to 
be copied to the Goods Receipt PO as the Vendor Reference Number. 
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Pack Serials and Batches: Check this box if you want to have the ability to pack serial 
numbers and batches when manually receiving containers. 
 
Set PO Delivery Date: Check this box if you want to automatically change the PO due 
date when the Estimated Warehouse date is entered on the container. 
 

Prompt if PO is Earlier: Check this box if you enable the Set PO Delivery Date 
option and want to be prompted if the current PO due date is earlier than the 
Estimated Warehouse date that is entered. 

 
Reset Container PO Lines on repack: Check this box if you want to clear all of the PO 
contents line row numbers when the re-pack button is selected. 
 
Container Serial is Unique: Check this box if you do not want to allow the same serial 
number to be used for multiple containers. 
 
Use Pre-Billing: Check this box if you will use the pre-billing feature to create A/P 
Reserve Invoices. 
 

Pre-Billing Default: If the pre-billing feature is used, check this box if you wish to 
mark all Containers for pre-billing by default. 
 
Use Invoice Approvals: If you use standard SAP Approvals for AP Invoices, check 
this box. 
 

Display PO Selection Order: Select which order PO items should be sorted on the PO 
Selection screen; Line Number Order or Item Order. 
 
Additional Field for PO Selection: If desired, you may specify any field from Purchase 
Order header or row tables to appear on the PO Selection screen.  The field may be used 
to indicate specific parameters relating to the purchase orders which may help to 
determine which one to select for a shipment.  Click on the drop-down arrow to see a 
list of all available fields, including user-defined fields. 
 
 
 
 
 
 
 
 
 
 



  
 

8 | P a g e  A c h i e v e  C o n t a i n e r  M a n a g e m e n t  U s e r  G u i d e  

 

Container Types 
 
Administration > Achieve One Set Up > Achieve Container Management > Container 
Types 
 
You must define one or more container types by size. 
 

 
 

 
Container Type Code: The code number will be entered automatically by the system. 
 
Description: Enter a description for the container type (50 characters). 
 
Container Length: Enter the length. 
 
Container Width: Enter the width. 
 
Container Height: Enter the height. 
 
Container Volume: The system automatically calculates the container volume. 
 
Weight Restriction: Enter the maximum weight allowed for this type of container. 
 
Attributes:  Enter any relevant characteristics of this container type; e.g., refrigerated, 
air shipment only, etc. (250 characters). 
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Container Ship Via 
 
Administration > Achieve One Set Up > Achieve Container Management > Container Ship 
Via 
 
You must create one or more ship via codes.  These provide approximate timeframes for 
shipments to arrive at port, clear customs, and arrive at the warehouse.  The dates may 
be changed for each individual shipment. 
 
 

 
 
 
Ship Via: Enter a code for the ship via (30 characters). 
 
Description: Enter a description for the ship via (100 characters). 
 
Days to Arrival at Port: Enter the number of days from shipment to arrival at port. 
 
Days to Clear: Enter the number of days from shipment to customs clearance. 
 
Days to Whse: Enter the number of days from shipment to arrival at the warehouse. 
 
Note: The number of days for the stages of the shipment are from counted from 
Shipment date and are not cumulative; in the example above, the container is expected 
to arrive at port 28 days after shipment, clear customs 5 days later, and arrive at the 
warehouse in 2 more day, for a total of 35 days from shipment to warehouse. 
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Container Header Fields 
 
Administration > Achieve One Set Up > Achieve Container Management > Container 
Header Fields 
 
Due to differences between various industries and individual companies, there may be 
information that would be of use to you but is not included in the Container Tracking 
screen.  Therefore, it is possible to create your own user-defined fields (UDF’s) and they 
will appear on the Container Tracking header.  You may create as many fields as you 
wish, but only six of them may appear on the main part of the screen; all fields will 
appear in the standard user-defined field panel. 
 
Create the user-defined fields for the Container Header table listed under the User 
Tables section in Tools > Customization Tools > User Defined Fields – Management. 
 
 

 
 
 
You may create fields of any type or length.  The only restriction is that the field name 
may not begin with “AIS”, since that is a prefix reserved for Achieve IT Solutions.  If 
desired, you may enter valid values for the fields, so that a drop-down list of choices will 
appear when the field is used on a document. 
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Once the fields have been created, you may enter the screen. 
 
 

 
 

 
Select up to six fields for display on the Container Tracking header.  The drop-down list 
will display all user-defined fields that have been created for the container header table, 
except for those that are normally installed with Achieve Container Management, and 
any others that begin with “AIS”. 
 
 
The selected fields will then appear on the Container Entry screen. 
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If you later decide to remove the fields from the screen, you can come back into the 
Container Header Fields screen and do so.  This will not remove any data that has been 
entered in these fields, since they will still exist in the database.  You will be able to view 
them by activating the User-Defined Fields panel from the View pull-down menu.  You 
may reinstate them in the header at any time. 
 
However, if you delete one of the fields from the database by means of the User-
Defined Fields Management program, it will be gone permanently and all data that was 
entered in it will be lost. 
 

Container Row Fields 
 
Administration > Achieve One Set Up > Achieve Container Management > Container Row 
Fields 
 
Similar to the Header Fields, you also have the option of adding up to 6 fields on the 
Container Shipment Rows. The fields you have to choose from are all of the ones from 
the Purchase Order screen including UDFs. 
 
 

 
 
 
Select up to 6 fields and hit update. The selected fields will then appear on the 
Container Entry screen. 
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If you later decide to remove the fields from the screen, you can come back into the 
Container Row Fields screen and do so.   
 

Pre-Defined Landed Costs and Distributions 
 
Administration > Achieve One Set Up > Achieve Container Management > Pre-Defined 
Landed Cost Code 
 
If you are using landed costs and you use the same ones over and over again, you can 
use this screen to set up pre-defined landed cost templates to make it easier to assign 
them in the Container Entry screen. 
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Pre-Defined Landed Cost Code: Enter a code for the template (30 characters). 
 
Description: Enter a description for the code (100 characters). 
 
Landed Cost Code: Select the landed cost code from the list of standard SAP options. 
 
Landed Cost Description: This will get filled in after you select the landed cost code. 
 
Landed Cost Allocation By: Select the allocation method from the list of standard SAP 
options. 
 
Landed Cost Amount: Enter in the amount for this landed cost line. 

 
After you have entered in all of the lines for this template hit “Add”. 
 
Once they have been added you can use them in the Container Entry screen which we 
will see later on in this document. 
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Container Entry Processing 
 
The following instructions will demonstrate how to enter and maintain Container 
Management information in SAP Business One.  
 
Note, once a Container shipment is entered it will need to be updated several times as 
new information is received.   
 
Open the Container Entry Processing program from the menu. 
 
Achieve One > Achieve Container Management > Container Entry Processing 
 
The Container Entry document is initially created when you are informed that items are 
ready to ship and you have the carrier information and BOL number.   
 

Step 1: Enter Header Information 
 

 

 
 

 
Shipment: The shipment number will be entered automatically by the system. 
 
Broker: Enter the Broker ID (30 characters). 
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Pre-Billed: This box only appears if pre-billing was selected in the Container Defaults.  
Check the box if items on this container will be pre-billed. 
 
Currency: Select if you want the currency displayed in System or Local Currency 
 
Carrier: Enter the carrier or ship name (30 characters). 
 
Ship Via: Select the Ship Via from your list of options. 
 
Est. Departure Date: Enter the Estimated Departure Date, which is the date when the 
items are expected to ship from the foreign port. The system will automatically calculate 
the estimated dates for arrival, clearing, and receipt at the warehouse based on the Ship 
Via settings.  You can change these dates if necessary. 
 
Est. Arrival Date: This field represents the date the material is expected at the 
destination port. 
 
Est. Clear Date: This field represents the date the material is expected to clear customs 
and be available for transport to the warehouse 
 
Est. Warehouse Date: This field represents the date the material is expected to arrive at 
the warehouse.  
 
BOL #: Enter the Bill of Lading number (30 characters). 
 
Status: The status is initially set to “Planned”.  This will be changed as the shipment 
progresses through its stages. 
 
Departure Date: This field will be left blank initially.  The system date will be filled in as 
the shipment completes each stage and the actual dates of each event are known. 
 
Arrival Date: This field will be left blank initially.  The system date will be filled in as the 
shipment completes each stage and the actual dates of each event are known. 
 
Clear Date: This field will be left blank initially.  The system date will be filled in as the 
shipment completes each stage and the actual dates of each event are known. 
 
Warehouse Date: This field will be left blank initially.  The system date will be filled in as 
the shipment completes each stage and the actual dates of each event are known. 
 
 
Remarks: Enter any desired remarks related to the shipment in the field at the bottom 
of the screen (200 characters). 
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Note: Other fields may appear on the Container Tracking header if user-defined fields 
have been created and defined in the Container Header Fields setup section.  
Appropriate data may be entered or edited in these fields at any time during the 
shipment process.  
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Step 2: Enter Items 
 

There are multiple ways to bring items into the Container Entry screen.  
 
Copy PO 
 
The first is by pressing “Copy PO” which brings up a list of vendors to select from. 
 
 

 
 

 
After you select the vendor, a second window opens up displaying the vendor’s open 
PO’s.  Use the triangle next to the PO numbers to expand the view so that you can see 
the individual items on each PO, or use the “Expand All” button at the bottom of the 
screen to see all of them.  
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Check the box in the “Selected” column to indicate which items are being shipped.  You 
can select all items from a PO by checking the box on the line that shows the PO 
number.  The system will also automatically check the box if you enter a value in the 
“Shipped Quantity” column.  

 

 If using Achieve Style, you may select all sizes of a style by checking the box 
on the line that shows the style code. 

 
Note: You may select items from more than one PO. 

 
For each item that is selected you can confirm or change the quantity to reflect the 
quantity that is being shipped. 
 
When all quantities and items are complete press “Copy”. 
 
 
Enter PO - Quick Select 
 
The second option would be to use the Quick Select button right above the item grid.  
 
To use this option start by entering the PO Number you want to work with into the 
Enter PO field and clicking on Quick Select. 
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The PO item selection window will open up with only that one PO showing.  
 

 
 
 
Check the box in the “Selected” column to indicate which items are being shipped.  Note 
that you may select all items from the PO by checking the box on the line that shows the 
PO number.  The system will also automatically check the box if you enter a value in the 
“Shipped Quantity” column.  

 

 If using Achieve Style, you may select all sizes of a style by checking the box 
on the line that shows the style code. 
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For each item that is selected you can confirm or change the quantity to reflect the 
quantity that is being shipped. 
 
When all quantities and items are complete press “Copy”. 
 
 
Enter PO - Quick Add 
 
The third option would be to use the Quick Add button right above the item grid.  
 
To use this option start by entering the PO Number you want to work with into the 
Enter PO field and clicking on Quick Add. 
 

 
 
 
All open line items and quantities from that PO will then be automatically copied into 
the Container Entry without the user to have to make any manual selections. 
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No matter which method you use, the system copies the selected items and quantities 
into the Container Entry.   

 

 
 
 
If necessary, repeat the process to select more items from different vendors and 
purchase orders.    
 
Press “Add” to save the Container entry. 

 
  



  
 

23 | P a g e  A c h i e v e  C o n t a i n e r  M a n a g e m e n t  U s e r  G u i d e  

 

Step 3: Enter Container Details 
 

Pull the Container Entry document back up on the screen and go to the Container 
Details tab. 
 

 
 
It is necessary to “pack” the shipment to indicate what containers are being used and to 
record the tracking numbers.  There are two methods of packing the shipment. 
 
Fast Pack 
 
To indicate that all items and quantities are to be shipped in one container, press “Fast 
Pack Items”. The container selection screen appears.  Enter the container type and 
tracking number.  You may press TAB to see a list of valid container types. 
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Select the container type, and enter the tracking number.  When the information has 
been entered, press “Pack”.  The screen displays a summary of the container’s contents.  
You may view it by item or by container. 
 
 

 
 
 
Pack Items 
 
If your shipment is being sent in multiple containers you can use the “Pack Items” 
option instead of “Fast Pack” to have more control over which items and quantities are 
in which specific containers. 
 



  
 

25 | P a g e  A c h i e v e  C o n t a i n e r  M a n a g e m e n t  U s e r  G u i d e  

 

 
 
 
Select the container type for the first container and enter its serial and tracking 
numbers.  You can also enter in a Seal number or Vendor ASN number if you have that 
information.  
 
Then select the items that are packed in this container and enter their quantities (partial 
or full) into the “Quantity To Pack” field. Entering a value into that field will update the 
“Inventory Qty” field. You can also enter values directly into the “Inventory Qty” field, 
however if you do that, the “Quantity To Pack” field will NOT be updated. This was 
designed to make fractional changes to the inventory quantity without updating the 
actual SAP quantity. 
 
If you scroll over in the grid you will see a few more fields that you may want to use. You 
can enter in the Number of Packages that make up each line item’s quantity. There are 
also fields for the Packed Weight and Packed Volume which will be filled in 
automatically based on the quantity of each item you pack and the weight and volume 
of that item. That data will come from the Item Master record but you can override 
those values if necessary. This data is informational only.  
 
Note: The right side of the header also displays some information. It will show you the 
container volume, weight, the percentage of the container that is full and the space 
remaining.  This data is also informational only.  
 
When the first container is completed, click on “Pack”, then update the container entry 
document.  Repeat this process for additional containers until all of the items have been 
packed.  Individual containers may have different tracking numbers or they may all have 
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the same tracking number.  The tracking number for the first container will default to 
subsequent containers but may be changed. 
 
When all items are packed, the screen displays the items in their respective containers. 
 
 

 
 
 
The packed quantity of each item will appear on the PO Items tab in the “In-Transit Qty” 
column.  
 
Note: You can clear the packing information by clicking the “RePack Items” button on 
the Container Details tab. 
 
You can also change some of the package contents while they are still packed. If you 
click on the gold drill down arrow next to the Container Serial number it will open up the 
Container Master Data screen. In here you can edit the Quantity to Pack, the Inventory 
Quantity and the number of packages. There is also the option to change the Status of 
this specific container but we will discuss where that comes into play later on in this 
document. 
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If you right-click on an item line you will have the option to open the same window by 
choosing Edit Package Detail Row. You can also delete a package row with the right-click 
option and choosing Delete Package Detail Row. 
 
Right-clicking on the Container Serial Number row you can either Delete or Edit the 
Package Header. If you choose Edit, the Container Master Data Header window will 
open up for you to make changes. 
 
 

 
 
 
There are two other buttons on the bottom of the Container Details tab; Reset Scanned 
(only if using Achieve Warehouse Management) and Mark All Finished, which we will 
discuss later in this document. 

Step 4: Enter Projected Landed Costs 
 
Entering projected landed costs on the Container document is optional.  It provides a 
way to estimate the actual cost of the items before they are received into the 
warehouse.  However you may skip this step if you do not use the Landed Cost feature 
of SAP Business One or if you do not know the costs until after the shipment is received. 
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You may enter projected landed costs whenever you are notified of them.  It is not 
necessary to enter all costs at the same time.  It is desirable but not required to have all 
costs entered by the time the items are received into the warehouse. 
 
Note that the list of available landed cost types is taken from the standard list found in 
Administration > Setup > Purchasing > Landed Costs.  Each cost type must include the 
appropriate GL account.  You may access this entry screen by clicking on the “New 
Landed Cost” button. 
 
Go to the Projected Landed Costs tab.  Click on the first line, and select the code for one 
of the landed cost types.  The allocation method for that expense defaults from the 
landed cost setup but you may change it if desired.  Enter the amount of each cost type 
for this shipment. 
 
 

 
 
 
If you have set up Pre-Defined Costs during your Container Management setup you can 
use the selection button to copy those to the grid instead of manually typing them all in. 
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When all entries are complete, press “Calculate PO Cost”.  Note that if the calculation is 
not possible (for example the allocation method is by weight but one or more items on 
the shipment do not have any weight entered in the Item Master), you will receive an 
error message.  You may correct the Item Master and then calculate the landed costs 
again. Press “Update” to save the changes. 
 
When the costs are calculated, they are apportioned to the items according to the 
allocation method for each cost.  The PO Items tab displays the calculated landed cost 
for each item per unit, and the total landed cost for each row. 
 
 

 
 

 
Note: You may add more landed costs or change existing amounts at any time before 
the actual Landed Cost function is performed. 
 
If you choose to assign standard SAP Customs Groups to individual items, the program 
will calculate the customs percentage and amount for each item on the container then 
add this amount to the apportioned amounts for the landed costs.  In this case, customs 
should not be included in the list of landed cost types. 
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Step 5: Container Links 
 
The Links tab of the Container Entry screen allows you to attach various documents 
relating to the shipment.  These may be scanned shipping documents, spreadsheets, 
PDF copies of sales orders, or any other type of file that is saved on your network. 
 
 

 
 
 
To link a document, place the cursor on the first empty Full File Name line on the screen.  
Then type the full path name of the file or use the “Browse” button at the bottom to 
search for it in Windows Explorer. Remember that if you want this file to be accessible 
to all users from all machines, the path must be to a network share that they will have 
access to.  If the file is printable, check the box at the beginning of the row. Repeat until 
all linked documents are entered and hit “Update”. 
 
You may display or print the file at any time by using the buttons at the bottom of the 
screen.   
Note: The program necessary to open the file (Acrobat, Excel, Word, etc.) must be 
installed on the SAP server and the local user’s machine. 
 
Links may be added or changed at any time during container processing. 
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Step 6: Extended Remarks 
 
The Extended Remarks tab provides space for any instructions, references, or other 
information regarding the shipment.  You may enter up to 256,000 characters in this 
space. 
 
 

 
 
 
Extended remarks may be entered, added, or edited at any time during container 
processing. 
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Container Processing 
 
After the initial entry of the container information, the shipment will go through a 
number of stages before it reaches your warehouse.  As each stage occurs you can 
update the Container Entry document so that the status is current and any new 
information is included. 

Pre-Billing 
 
If the items are invoiced before they are received you can use the pre-billing feature to 
enter the invoice as long as the status is either Shipped, At Port or Cleared.   
 
To start make sure the Pre-Billed box on the top of the screen is checked off. Next, 
highlight the rows that are included on the invoice and click “Reserve Inv” to create an 
A/P Reserve invoice.   
 
 

 
 
 
A message appears to remind you that creating the Reserve Invoice will close the PO 
rows and that invoices cannot be changed once they are added.  Click on “Yes” to 
continue. 
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The system opens the A/P Reserve Invoice screen and creates the invoice for the items 
that were selected.  The document is not added automatically though. Enter a posting 
date and make any other changes if necessary (e.g. change the prices of the items if 
they do not match the actual invoice received from the vendor). 
 
When the invoice is correct, click on “Add”.  The screen returns to the Container 
document.  The Reserve Invoice number is now displayed on each row. 
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Note: It is possible that not all items are invoiced on the same document.  In this case 
select the items for the first document and create the Reserve Invoice, then select 
additional items for a second Reserve Invoice.  If items from different POs are selected 
together they will be combined into a single Reserve Invoice. 
 
In the case of items from multiple vendors you may select all items from different 
vendors together and the system will create a separate A/P Reserve Invoice for each 
vendor. 
 
If prices were changed on the Reserve Invoice the system will automatically change the 
prices on the container entry document to match the new prices.  Landed costs will also 
be recalculated accordingly. 
 
 
Note: If the Use Pre-Billing setting is not selected in the Container Management 
Configuration screen, then none of the above features will be available in container 
entry.  
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Change Container Status 
 
You may change the status of the container as information is received about its 
progress.  Note that it is not necessary to use each status.  For example, if the shipment 
is pre-cleared by customs you may skip “At Port” and go directly to “Cleared”. 

Ship Items 
 
To indicate that the items have been shipped, press the “Set Container Status” button 
and select “Shipped”. 
 
 

 
 

 
The status code changes to “Shipped” and the current date is entered as the departure 
date.  You may change the date if necessary.  Press “Update” to save the changes. 
 
Note: You cannot change the status to Shipped until the shipment has gone through the 
packing process. 
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Items At Port 
 
When the shipment arrives at the port, press the “Set Container Status” button and 
select “At Port”.   
 

 
 

 
The status is changed to “At Port” and the current date is entered as the arrival date.  
You may change the date if necessary.  Press “Update” to save the changes. 
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Clear Customs 
 
When the shipment clears customs, press the “Set Container Status” button and select 
“Cleared”. 
 
 

 
 

 
The status is changed to “Cleared” and the current date is entered as the clear date.  
You may change the date if necessary.  Press “Update” to save the changes. 
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Warehouse Receiving 
 
If using Achieve Warehouse Management, this is the status that the Container must be 
set to before you can receive it on your handheld devices. 
 
When the shipment is ready to be received on the handhelds, press the “Set Container 
Status” button and select “Warehouse Receiving”. 
 
 

 
 
 
See the section below labeled Container Management with Achieve Warehouse 
Management for this full process. 
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Receive Items 
 
(Note: If using Achieve Warehouse Management, see the section below labeled 
Container Management with Achieve Warehouse Management for the full receive items 
process). 
 
When receiving any item into the warehouse it is important to verify that the shipment 
is accurate.  Warehouse personnel should compare the items received to those on the 
container document or on the original Purchase Order(s).  If there are any discrepancies 
in the items or their quantities it should be noted. 
 
When discrepancies exist the container entry document must be changed to reflect the 
actual receipt.  To do this you may have to edit or delete container detail or headers 
rows. You may also have to use the “RePack Items” function to completely clear the 
packaging so that adjustments can be made. If you clear the packaging you will need to 
pack the again using either the “Fast Pack” or “Pack Items” options after you make your 
adjustments. 
 
Note: If you are receiving items into a Bin enabled warehouse you will need to pay 
attention to the Warehouse Location field on the PO Items tab. Based on your SAP 
settings it should default a location into that field for you. If it does not or you just want 
to change the bin location that the line items should be received into, make sure to 
update it now before you change the status to “Received”. 
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Once the receipt is verified and any corrections have been made, you will need to mark 
the completed containers as “Finished”. To do this go to the Container Details tab. 
 
If you are only receiving in some of the containers on the shipment you can mark them 
Finished individually by opening up their Container Master Data screens (which we saw 
earlier) and changing their statuses to “Finished”. 
 
 

 
 
 
If you are receiving all of the containers on the shipment then you can set them all as 
“Finished” at once by clicking on the Mark All Finished button on the bottom of the 
screen. 
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Now that the containers are marked as “Finished” press the “Set Container Status” 
button and select “Received”. 
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As the status is changed it will confirm that you want to receive this shipment. Click on 
OK and it will try to create Goods Receipt PO’s for the items and quantities on the 
container entry document. 
 
 

 
 
 

 
 

 
This is the receiving document which indicates that the items have been added to 
inventory.  Note that the Goods Receipt PO cannot be changed once it is created. 

 
During the creation of the Goods Receipt PO, if any of the items are managed by serial 
numbers or batches, the program will stop so that the serial or batch numbers may be 
entered.  You will then need to add the document manually. 
 
If multiple PO’s or Reserve Invoices from the same vendor are included in the Container 
they will be combined into one Goods Receipt PO.  If PO’s or Reserve Invoices from 
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multiple vendors are included, the system will create one Goods Receipt PO for each 
vendor.  Each Goods Receipt PO will be in the currency of its original base PO or Reserve 
Invoice. 
 
The initial Goods Receipt PO number will be displayed in the footer area of the screen.  
In addition, each row displays the Goods Receipt PO number for that item. If there are 
multiple GRPOs, you can double click the field to get a complete listing for that line.  
 
 

 
 

 
On the original PO’s or Reserve Invoices, any row that has been received completely will 
be closed.  Rows that have not been received or have been partially received will remain 
open.  If all rows are closed the document will be closed. 
 
The container entry document status will now be “Received” and the current date is 
entered as the warehouse date.  You may change the date if necessary.    
 
If you did not receive in all of the containers for this shipment, then when subsequent 
shipments come in you will follow the same process, starting with changing the 
container’s statuses to “Finished”. 
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Landed Costs 
 
When all of the landed costs have been entered, open the container document and 
press the “Landed Cost” button.  Note that the Goods Receipt PO must have been 
created prior to this step. 
 
The system opens a Landed Cost document which contains the items and costs from the 
container document.  You may accept this document or make changes to it. Once the 
document looks good you can add it. 
 

 

 
 
 

If Goods Receipts from multiple vendors were created, a separate Landed Cost 
document will be created for each vendor as well.  Each Landed Cost document will 
have the currency of its original base Goods Receipt PO and Purchase Order.  This 
currency is applied to both the item costs and the additional costs. 
 
Note: The standard SAP Business One functionality allows you to enter additional landed 
costs for the shipment at a later time creating a new Landed Cost document and using 
“Copy From” to copy in the original one. 
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Completed Shipment 
 
When all landed costs and Goods Receipt PO’s are finished, press the “Set Container 
Status” button and select “Complete”. 
 
 

 
 
 
The status changes to “Complete” and updates to save the changes.  No further changes 
may be made to the container entry document once this is done. 
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Voided Shipment 
 
If needed it is possible to void an entire container entry document. To do this, press the 
“Set Container Status” button and select “Void”. 
 
 

 
 
 
Once the container entry has been voided, the Purchase Orders on it will be available to 
be copied into a new shipment. 
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Container Management with Achieve Warehouse Management 
 
When you have Achieve Warehouse Management there are a couple of additional 
fields, buttons and processes that you need to be aware of. 
 
Container Status 
 
As we mentioned above there is an additional container status called “Warehouse 
Receiving”. This will be the status before Received that allows for a container shipment 
to be pulled up on the WMS handheld for receiving. 
 
PO Items Tab 
 
Scanned Qty 
 
There is a new column called “Scanned Qty” on the PO Items tab. This field represents 
the actual quantity of each item scanned on the WMS handheld during the container 
receiving. This is the quantity that will be used when the Goods Receipt PO’s are created 
from the container entry. 
 
Note: The quantity will be in the Inventory UoM. 
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Warehouse Location 
 
As mentioned earlier, the “Warehouse Location” field will get filled in based on your SAP 
default settings. However with WMS, as you are scanning in a container using the 
handheld, you are able to specify the warehouse bin locations for the items. After 
scanning is completed, those locations from the handheld will then be updated in the 
“Warehouse Location” field and subsequently used when the Goods Receipt PO’s are 
created from the container entry.   
 
Container Details Tab 
 
There is a new button on the Container Details tab called “Reset Scanned”. This button 
will clear out all of the scanned quantities from the containers on the shipment that 
have not yet been updated to a “Received” status. This will also clear out the WMS 
handheld records and set the containers back to an “Open” status so they can be 
scanned in again on the WMS handheld. 
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Container Reports 
 
Achieve One > Achieve Container Management > Container Reports 
 
Achieve Container Management includes five major reports, each of which can be run 
several different ways.  These reports provide the means to track each stage of the 
shipment process. 
 

By Item 
 
Achieve One > Achieve Container Management > Container Reports > By Item 
 
 

 
 
 
Set the selection criteria as follows: 
 
Container From/To: Enter the range of container documents to display or leave blank to 
include all containers. 
 
Item From/To: Enter the range of items to display or leave blank to include all items. 
 
Departure Date From/To: Enter the beginning and ending departure dates to display or 
leave blank to include all dates. 
 
In Whse Date From/To:  Enter the beginning and ending warehouse receipt dates to 
display or leave blank to include all dates (applies only to Received items). 
 
Container Status: Select one or more of the status designations to display (you must 
select at least one). 
 
When the selections are complete click on “Show Report”. 
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The report displays one line per item on each of the selected shipments. 
 
 

 
 
 
The report displays the shipment number, item code, container type, container number, 
status, as well as the estimated and actual dates for departure, arrival, clearance, and 
in-warehouse. 
 
You may highlight a line and double-click or click on the “Details” button to see 
additional detail.   
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You may also drill down on the shipment number and item number from the main 
screen, and the PO number and vendor from the detail screen. 
 

By Vendors 
 
Achieve One > Achieve Container Management > Container Reports > By Vendors 
 
 

 
 
 
Set the selection criteria as follows: 
 
Container From/To: Enter the range of container documents to display or leave blank to 
include all containers 
 
Vendor From/To: Enter the range of vendors to display or leave blank to include all 
vendors 
 
Departure Date From/To: Enter the beginning and ending departure dates to display or 
leave blank to include all dates 
 
In Whse Date From/To:  Enter the beginning and ending warehouse receipt dates to 
display or leave blank to include all dates (applies only to Received items) 
 
Container Status: Select one or more of the status designations to display (you must 
select at least one) 
 
When the selections are complete click on “Show Report”. 
 
The report displays one line per shipment, arranged by vendor code. 
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The report displays the vendor code and name, shipment number, container type, 
container number, status, carrier, as well as the estimated and actual dates for 
departure, arrival, clearance, and in-warehouse. 
 
You may highlight a line and double-click or click on the “Details” button to see 
additional detail of the Purchase Orders included on the shipment.   
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You may also drill down on the shipment number and vendor number from the main 
screen, and the PO number from the detail screen. 
 
 

By Customers 
 
Achieve One > Achieve Container Management > Container Reports > By Vendors 
 
This report will include only Container documents which are based on Purchase Orders 
that are linked to customer Sales Orders. 
 
 

  
 
 
Set the selection criteria as follows: 
 
Container From/To: Enter the range of container documents to display or leave blank to 
include all containers 
 
Customer From/To: Enter the range of customers to display or leave blank to include all 
customers 
 
Departure Date From/To: Enter the beginning and ending departure dates to display or 
leave blank to include all dates 
 
In Whse Date From/To:  Enter the beginning and ending warehouse receipt dates to 
display or leave blank to include all dates (applies only to Received items) 
 
Container Status: Select one or more of the status designations to display (you must 
select at least one) 
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When the selections are complete click on “Show Report”. 
 
The report displays one line per item on each of the selected shipments. 
 
 

 
 
 
The report displays the customer code and name, sales order number, delivery date, 
vendor code and name, PO number, shipment number, item code, container type, 
container number, status, as well as the estimated and actual dates for departure, 
arrival, clearance, and in-warehouse. 
 
You may drill down on the customer, sales order, vendor, purchase order, container and 
item. 
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By Tracking Number 
 
Achieve One > Achieve Container Management > Container Reports > By Tracking 
Number 
 
 

 
 
 
Set the selection criteria as follows: 
 
Container From/To: Enter the range of container documents to display or leave blank to 
include all containers 
 
Tracking Number From/To: Enter the range of tracking numbers to display or leave 
blank to include all tracking numbers 
 
Item From/To: Enter the range of items to display or leave blank to include all items 
 
Departure Date From/To: Enter the beginning and ending departure dates to display or 
leave blank to include all dates 
 
In Whse Date From/To:  Enter the beginning and ending warehouse receipt dates to 
display or leave blank to include all dates (applies only to Received items) 
 
Container Status: Select one or more of the status designations to display (you must 
select at least one) 
 
When the selections are complete, click on “Show Report”. 
 
The report displays one line per item on each of the selected shipments. 
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The report displays the tracking number, shipment number, broker ID, purchase order, 
item code and description, quantity and status. 
 
You may drill down on the shipment, purchase order and item. 

 

Inventory in Transit 
 
Achieve One > Achieve Container Management > Container Reports > Inventory in 
Transit 
 
If you are using pre-billing, this report is available.  It shows items that have been 
entered on pre-billed Container documents, and have been copied to Reserve Invoices.  
These items have been posted to the Stock in Transit account, and may be considered 
part of the company’s inventory value even though they have not yet been received into 
any warehouse. 
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Set the selection criteria as follows: 
 
Container From/To: Enter the range of container documents to display or leave blank to 
include all containers 
 
Vendor From/To: Enter the range of vendors to display or leave blank to include all 
vendors 
 
Item From/To: Enter the range of items to display or leave blank to include all items 
 
Departure Date From/To: Enter the beginning and ending departure dates to display or 
leave blank to include all dates 
 
In Whse Date From/To:  Enter the beginning and ending warehouse receipt dates to 
display or leave blank to include all dates (applies only to Received items) 
 
Note that there is no selection for status on this report. All items which meet the above 
criteria and are currently on open Reserve Invoices will be included.  The status of the 
related container documents may be Shipped, At Port or Cleared. 
 
When the selections are complete, click on “Show Report”. 
 



  
 

59 | P a g e  A c h i e v e  C o n t a i n e r  M a n a g e m e n t  U s e r  G u i d e  

 

 
 
 
The report shows the item code and description, vendor code and name, PO number, 
container number, reserve invoice number, quantity, unit price, total price, estimated 
landed cost per unit, estimated total landed cost and the status of the container. 
 
You may drill down on the item, vendor, PO, container and reserve invoice. 
 
 

Container Entry Document Report 
 
To print the Container Entry Document Report that we set earlier in the Container 
Management Configuration, just click on the “Print” button on the bottom of the 
Container Entry screen. 
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View Container Details 
 
You may view Container information for items on Purchase Orders and linked Sales 
Orders. 
 

Purchase Orders 
 
Once an item has been copied from a Purchase Order to a Container entry document 
you can view its status from within the Purchase Order.  If partial quantities have been 
shipped on different Containers you will see the detail of all shipments. 
 
On the Purchase Order screen, highlight a row and right-click.  Select “View Container 
Details”.  You can also find this option in the Data menu at the top of the SAP Business 
One screen. 
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A window opens to display information about all Container shipments that are linked to 
this PO and item. 
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The display includes the container number, quantity, status, as well as the estimated 
and actual dates of shipment, arrival at port, customs clearance and arrival at the 
warehouse.  If the shipment has been received, the Goods Receipt PO number is shown 
with drill-down. 
 
There are also two new fields on the Purchase Order rows; Container Quantity Shipped 
and Container Quantity Processing.  
 
 

 
 

Sales Orders 
 
When a Sales Order has been linked to a Purchase Order, and the items have then been 
copied to a Container, you can view the Container details from within the Sales Order 
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screen.  If partial quantities have been shipped on different Containers, you will see the 
detail of all shipments. 
 
On the Sales Order screen, highlight a row and right-click.  Select “View Container 
Details”.  You can also find this option in the Data menu at the top of the SAP Business 
One screen. 
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A window opens to display information about all Container shipments that are linked to 
this Sales Order and item. 
 
 

 
 

 
The display includes the PO number, vendor code, container number, quantity, status, 
as well as the estimated and actual dates of shipment, arrival at port, customs clearance 
and arrival at the warehouse.  If the shipment has been received, the Goods Receipt PO 
number is shown with drill-down. 


